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These release notes include the following topics:

1.0 Identifying Your ACS Software Revision Level

2.0 Hardware and Software Support

3.0 New Features

4.0 Configuration Rules

5.0 Operating Constraints

6.0 Saving Your Configuration

7.0 Avoiding Problem Situations

8.0 Host Operating System Notes

9.0 Using the HSG80 Controller in a Modular Solution

10.0 StorageWorks Command Console (SWCC)

11.0 Documentation Update

Release Package Contents

The HSG80 ACS Version 8.5C Solution Software kit consists of the following:

• The HSG80 Solutions documentation set:

-- Modula Array Configuration Guide EK-MACON-CA. A01

-- Compaq StorageWorks Command Console V2.3 User Guide
AA-RFA2G-TE

-- RA8000/ESA12000 and MA8000/EMA12000 HSG80 Array Controller
StorageWorks Solution Software Kit Overview EK-SOLSR-AA. B01

-- HSG80 Array Controller ACS Version 8.5 CLI Reference Manual
EK-HSG85-RG. A01

-- HSG80 Array Controller ACS Version 8.5 Maintenance and Service
Guide EK-HSG84-SV. C01
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-- Registration
RA7000/8000, ESA10000/12000 and MA8000/EMA12000
EK-RAESA-RC. D01

-- StorageWorks Warranty Package
Warranty Terms and Conditions  EK-HSXSW-WC. C01
Warranty Terms and Conditions Addendum  3R-Q178A-3V. B01
158199-021

-- Compaq StorageWorks HSG60/HSG80 Array Controller ACS Version
8.5C Solution Software for IBM AIX Installation and Configuration Guide
(AA-RNJ8A-TE)

• HSG80 IBM-AIX CDROM containing documentation and StorageWorks
Solution software

Intended Audience

This document has been prepared for customers who have purchased the
RA8000, ESA12000, MA8000, or EMA12000 with an HSG80 controller, and for
Compaq Customer Services personnel responsible for installing and maintaining
systems that include the HSG80 array controller.

 Visit our Web Site for the Latest Information

 Check our web site for the latest drivers, technical tips and documentation for
the HSG80 Array Controller. We can be found in the technical area of our web
page:

http://www.compaq.com/support
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1.0 Identifying Your ACS Software Revision Level

 Included in this section are instructions on a number of methods that may be
used to determine if the RAID Array is running the correct revision of ACS
Software.

 Once installed, you can identify the specific version of ACS Software version by
entering the following command at the Command Line Interpreter (CLI), prompt:

 HSG80>  SHOW THIS_CONTROLLER

 The resulting display lists the software revision level.  If the ACS Version is not
V8.5F, contact your support provider for instructions on how to obtain the
updated version.

 2.0 Hardware and Software Support

 This section lists the hardware, devices and operating system revisions that are
compatible with ACS software Version 8.5F.

 2.1  Hardware Support

 ACS Software Version 8.5F supports the following revisions for the
RA8000/ESA12000 and MA8000/EMA12000 and associated hardware:

• DS-SW600-AA—600-mm wide cabinet 50/60 Hz, dual-redundant
controllers, bolting kit for coupling (two SW600 cabinets)

• DS-SW370-AA—RAID pedestal, five 180-watt power supplies; eight
universal 50/60 Hz 120/240V high-powered blowers; one AC input box; one
enhanced EMU; one pedestal user’s guide; six single-ended I/O modules

• DS-SW370-EA—RAID pedestal; five 180-watt power supplies; eight
universal 50/60 Hz 120/240V high-powered blowers; one AC input box; one
enhanced EMU; one pedestal user’s guide; six single-ended I/O modules;
metric mounting hardware

• DS-BA370-AA—RAID rackmount enclosure; five 180-watt power supplies;
eight universal 50/60 Hz 120/240V high-powered blowers; one AC input
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box, six single-ended I/O modules; one pedestal user’s guide; one
enhanced EMU; one PVA, metric mounting hardware

• DS-BA370-MA—Maintenance Option for the SW370 and BA370 field
service Option, field-replaceable unit (FRU)

• DS-BA35X-HH—180-watt, 100 to 200-volt power supply, 240-volt, AC
factor-corrected power supply, blue color carrier

• DS-BA35X-MK—High-powered blower for the SW370 and BA370

• DS-BA35X-MN—Single I/O termination module

• DS-BA35X-MP—Termination module

• DS-BA35X-BA—External cache battery shelf for SW370

• DS-BA35X-BC—Single battery in blue SBB

• DS-BA35X-BD—Double battery in blue SBB

• DS-BA35X-EB—Enhanced Environmental Monitor Unit of the SW370 and
BA370

• DS-BA35X-MN—Single-ended, Ultra-SCSI I/O module

• DS-BA35X-EC—Power verification and addressing module

• HS35X-BA—Single external cache battery in an SBB

• HS35X-BD—Dual external cache battery in an SBB

• DS-HSDIM-AB 64 MB Cache upgrade for HSX80

• DS-HSDIM-AC 256 MB Cache upgrade for HSX80

 2.2  Device Support

 ACS Software Version 8.5F supports the devices listed in Table 1 at the
indicated hardware and microcode levels.
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 Table 1  Supported Disk Drives

Device
Capacity in
Gigabytes

Spindle
Speed
(RPM)

Minimum
Microcode

Version

Minimum
Hardware
Version

DS-RZ1CB-VW 4.3 7,200 LYJ0 or 0656 A01

DS-RZ1CD-VW 4.3 10,000 0306 A01

DS-RZ1DB-VW 9.1 7,200 LYJ0 or 0307 A01

DS-RZ1DF-VW 380595-B21 9.1 7,200 N1H1, 0372, or
1614

A01

DS-RZ1DD-VW 380588-B21 9.1 10,000 0306 A01

DS-RZ1EF-VW 380694-B21 18.2 7,200 N1H1 or 0372 A01

DS-RZ1ED-VW 380589-B21 18 10,000 0306 A01

DS-RZ1DA-VW 147497-001 9 7,200 3B05 A01

DS-RZ1EA-VW 147598-001 18 7,200 3B05 A01

DS-RZ1FB-VW 147599-001 36 7,200 3B06 A01

123065-B22   BB00911CA0 9.1 7,200 3B05 A01

388144-B22   BB01811C9C 18.2 7,200 3B05 A01

128418-B22   BD018122C9 18.2 10,000 B016 A01

328939-B22   BD009122BA 9.1 10,000 3B07 A01
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 2.3  Operating System Support

 The RA8000/ESA12000 and MA8000/EMA12000 Version 8.5C Solutions
Software is supported on the following IBM AIX platforms and host adapters.

 Table 2  Minimum System Requirements

Host Feature Requirements

Platform IBM-AIX

Architectures RS6000, SP

Operating System AIX 4.2.1, 4.3.0, 4.3.1, 4.3.2, 4.3.3

Free Disk 2MB minimum

Fibre Channel Adapter Compaq/Cambex PC1000F Fibre Channel Adapter,
Compaq p/n 197819-B21

Fibre Channel Topology Switched (FC-SW) and Loop (FC-AL) Modes

Bus PCI
(Micro-channel not supported)

Controller HSG80 Array Controller Software (ACS) V8.5F
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2.4  StorageWorks Command Console

NOTE

The SWCC User Guide is titled Compaq
StorageWorks Command Console V2.3 User
Guide. V2.3 here refers to the entire software
suite revision.

The StorageWorks Command Console (SWCC) version 2.3 is included in this
release. This provides a graphical user interface that can be used to configure
and monitor your storage subsystem. Use of SWCC is highly recommended.
Refer to the Compaq StorageWorks Command Console V2.3 User Guide for
information about installing and using SWCC.

Identifying Your SWCC Software Revision Level

The StorageWorks Command Console Client software suite for the HSG80
V8.5C consists of various components. The following SWCC components are
included in this release of the Solution Software kit:

Table 3  SWCC Components

Component Version Number

SWCC Command Console (storage window manager) V 2.2.0.213

SWCC CLI Window V 2.0.0.33

HSG80 ACS85 Storage Window V 2.3.0.13

HSG80 Storage Window V 2.1.0.28

HSG60 Storage Window V 2.3.0.4

HSZ Storage Window V 2.3.0.47

HSZ80 Storage Window V 2.3.0.15

HSD Storage Window V 2.0.0.5

HSJ Storage Window V 2.0.0.5
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 Verify the individual components using Windows Explorer by performing the
following actions:

1. Right click on the particular executable program in its folder.

2. Select the Properties option.

3. In the resulting Properties window, click on the Version tab.

4. Select the Product Version to display the version of the program.

 3.0 New Features

 This section briefly describes features that are supported by the HSG80
controller. For more information on these features, see the HSG80 Array
Controller ACS Version 8.5 Configuration Guide and the HSG80 Array Controller
ACS Version 8.5 CLI Reference Manual.

3.1  External Cache Battery (ECB)

 COMPAQ recommends that you replace the ECB every two years to prevent
battery failure.

 If you are shutting down your controller for longer than one day, complete the
additional steps in “Shutting Down the Subsystem” in Compaq StorageWorks
HSG60/HSG80 Array Controller ACS Version 8.5C Solution Software for IBM AIX
Installation and Configuration Guide (AA-RNJ8A-TE). This will prevent the ECB
from discharging during planned power outages.

 3.2  CLI Commands

 ADD CONNECTIONS and SET CONNECTIONS now support the
following operating systems:

• TRU64 UNIX • VMS

• WINNT • IBM∗

• HP • SGI

• NOVELL NETWARE • SUN
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 NOTE∗

 Although an IBM operating system entry is
present in the CLI and SWCC for the Fibre
Channel connection, use default setting "WINNT"
for operation with your IBM host. The IBM setting
may cause problems when the LUNs are not
available to AIX or during a controller failover.

 3.3  Host Ports

 Each controller has two host ports. You can specify a maximum of 64 units per
port. Refer to the Compaq StorageWorks HSG60/HSG80 Array Controller ACS
Version 8.5C Solution Software for IBM AIX Installation and Configuration Guide
(AA-RNJ8A-TE) for information about unit numbering.

 

 4.0  Configuration Rules

 The following list outlines the configuration rules for the controller:

• Maximum 128 visible LUNs/200 assignable unit numbers

• Maximum 512 GB LUN capacity

• Maximum 72 physical devices

• Maximum 20 RAID-5 storagesets

• Maximum 30 RAID-5 and RAID-1 storagesets

• Maximum 45 RAID-5, RAID-1, and RAID-0 storagesets

• Maximum 8 partitions of a storageset or individual disk

• Maximum 6 members per mirrorset

• Maximum 14 members per RAID-5 storageset

• Maximum 24 members per stripeset

• Maximum 48 physical devices per striped mirrorset
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5.0 Operating Constraints

This section describes the operating constraints for ACS Software Version 8.5F.
An operating constraint is a limitation placed on the operation of the controller.
Other constraints on host adapters or other system components may also
apply. Keep these constraints in mind to avoid problems and to help achieve the
maximum performance from your controller.

5.1  Dynamic Volume Expansion

Creates a specialized volume, called a concatset (short for concatenation set),
from a storageset that has been given a unit number. Another storageset can
then be added to the concatset by the SET concatset command.

Dynamic volume expansion is not supported for IBM AIX.

5.2  Using FRUTIL to Insert a New Controller

When using FRUTIL to insert a new controller in a dual-redundant controller
configuration, the user will see a new set of instructions after the new controller
has been inserted:

If the other controller did not restart, follow these steps:

1. Press and hold the other controller’s reset button.

2. Insert the other controller’s program card.

3. Release the reset button.

NOTE

Whenever you are running FRUTIL you must
quiesce all I/O.

5.3  Dual External Cache Battery (ECB) Failures

The HSG80 Array Controller cache policy provides for proper handling of a
single ECB failure as described in Table 2-8 of the HSG80 Array Controller ACS
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Version 8.5 Configuration and in the HSG80 Array Controller (ACS) Version 8.5
CLI Reference Manual. For dual ECB failures, Table 2-8 states that no failover
occurs. For this release, if a dual ECB failure is detected both controllers will be
restarted.

6.0 Saving Your Configuration

6.1  Saving a Configuration to Previously Initialized Storagesets

When enabled, the SAVE_CONFIGURATION switch allows you to do the
following on single-configurations only:

• Save a configuration to a disk or storageset. The configuration may be
retrieved later and downloaded onto a replacement controller.

• Retain code patches to the ACS software.

 If any storageset within the configuration was previously initialized with the
INITIALIZE container-name SAVE_CONFIGURATION command to save your
configuration to disk, it will not be necessary to reconfigure your devices with a
new controller. SAVE_CONFIGURATION also retains code patch information to
the software. This option is supported on single controller configurations only.

 ACS Software Version 8.5F saves any installed software patches on disks
initialized with the SAVE_CONFIGURATION option. To replace a controller
and restore the configuration from a disk, you will not have to reinstall any
software patches.

 NOTE

 You must use the same software version when
replacing the controller. You can also hold in port
button 6 on the operator control panel, and press
the reset button to restore the configuration.

 Configuration information cannot be retrieved from storagesets created on other
HSx controllers (for example, HSD, HSJ, or HSZ controllers). You can only
restore a configuration from a configuration saved on this or another HSG80
array controller.
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7.0 Avoiding Problem Situations

 Under certain conditions, you may experience unusual controller behavior. This
section presents information to help you avoid such situations and to recover
from them if they occur.

 7.1  Adding, Moving, and Changing Devices

 The controller maintains a configuration map of a device’s type and location.
This map is used to communicate with devices. If you add, move, or change a
device while the controller is powered off without first changing the controller
configuration, the controller is not able to communicate with the changed
device when it returns to service.

 If a device is removed by mistake while the controller is off, restore power to
the controller then delete all containers associated with the removed device.

 If a device is replaced while the controller is off, remove the device before
restoring power to the controller. Correctly remove the current device and add
the new device after restoring power to the controller.

 See the HSG80 Array Controller ACS Version 8.5 Maintenance and Service
Guide for correct device removal and addition procedures.

 7.2  Moving Storagesets

 Move only normal storagesets. Do not move storagesets that are reconstructing
or reduced, or data corruption will result.

 7.3  Adding, Moving, and Changing Controllers, Cache Modules, or
External Cache Batteries

 It is permissible to replace the controller, cache module, or external cache
battery while the subsystem is shut down. However, you must enter the
SHUTDOWN THIS_CONTROLLER command before shutting the subsystem
down to make configuration changes. If two controllers are configured in a
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dual-redundant configuration, you must first enter the SHUTDOWN
OTHER_CONTROLLER command.

These commands instruct the controllers to flush all unwritten data
from the cache modules and discontinue all I/O activity. For more
information regarding the SET controller command or maintenance and
replacement of the controller, cache module, and external cache
battery, see the HSG80 Array Controller ACS Version 8.5 Configuration
Guide
and the HSG80 Array Controller ACS Version 8.5 CLI Reference
Manual.

 8.0 Host Operating System Notes

 8.1  Host Function

 Although an IBM operating system entry is present in the CLI and SWCC for the
Fibre Channel connection, use the default setting "WINNT" for operation with
your IBM host. The IBM setting may cause problems when LUNs are not
available to AIX or during a controller failover.

 Check the connection name with the following CLI command:

HSG80> SHOW CONNECTIONS

 Change the operating system connection type with the following CLI command:

HSG80> SET [CONNECTION NAME] OPERATING_SYSTEM=WINNT

 Where: [connection name] is the name of the connection with the status
listed as OL this (Online This) or OL other (Online Other) when the
SHOW CONNECTION command is entered.

 Once the connections have been made to WINNT, the SHOW CONNECTION
command should display WINNT in the Operating System column for the
connection name(s) set with the command above.
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8.2  Supported Adapters

The PC1000 adapter (Compaq P/N=149841-B21) is supported with this
release.  The PC1000 adapter is not capable of FC-SW operation, if your
application requires the FC-SW mode use the PC1000F adapter (Compaq
P/N=197819-B21) as it supports both FC-SW and FC-AL modes of operation.

8.3  Setting the dma_window Attribute

If your system has 1GB of memory or greater, and you are running AIX version
4.3.2, you must change the dma_window attribute for any installed PC1000F
adapters.  Your adapters will not be able to bind to any units when cfgmgr is
run.   The default setting is 256M, however systems with >1GB of memory
should use 64M.  Use the following commands to view/change this attribute:

To view the attributes for an adapter enter the following command:

# lsattr –El scsiX (where scsiX is the specific
adapter instance)

To change the attributes for an adapter enter the following command:

# rmdev –l scsiX (where scsiX is the specific
adapter instance to be changed)

# chdev –l scsiX –a dma_window=64M

# mkdev –l scsiX

8.4  Units Show Up as Defined, not Available

In certain circumstances, some units may not show as available after running
cfgmgr.   This is due to excessive unit attentions that can be caused by a unit
rebuilding, or some other informational events.  If this happens, run cfgmgr
again to clear the unit attentions and allow the units to show up as available.

8.5  Fibre Channel Loop Identifiers

Cambex Fibre Channel host adapters default to a SCSI target ID of 7.  To avoid
problems in FC-AL mode, when configuring the HSG controller use the AL_PAs
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listed in the MA6000 HSG60 Array Controller ACS Version 8.5C Solution
Software for IBM-AIX Installation and Configuration Guide (AA-RMC8A-TE).
These AL_PAs should be D5 for port 1, and D6 for port 2.

8.6  Adapter Driver Capabilities

This adapter driver release supports SCSI initiator mode only.  No target mode
support or IP support are planned.

8.7 AIX Boot Support

The ability to bootstrap the RS6000 from an HSG controller is not supported.

8.8  Multiple Agents Are Now Supported

This release of the RAID manager software contains an updated SWCC agent,
version 2.3 build 79 that supports locking, so multiple agents can be supported.
This feature is required to use the SAN Appliance in addition to the host-based
agent.

8.9  A Subsystem Name Cannot Use a Pipe Character

When adding a storage subsystem, do not use a pipe character ( | ) in the name.

8.10  Setting the SWCC Agent Monitoring Interval

During normal operation, do not set the agent monitoring interval smaller than
300 seconds (5 minutes).

8.11  Unknown Error Condition Message

With this release, the SWCC agent will generate the message “Unknown Error
Condition” in the event of a controller failure.  If you get this message, you
should use the SWCC client or CLI to determine the actual failure.  This will be
fixed in a later release.
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8.12  HACMP Support

This release of the Solution Software does support HACMP with the HSG
RAID systems.  The HACMP enabler software is provided on the CD-ROM.
Find the /hacmp directory on the CD-ROM for the enabler file.  For
information on setting up and managing HACMP, refer to the MA6000
HSG60 Array Controller ACS Version 8.5C Solution Software for IBM-AIX
Installation and Configuration Guide (AA-RMC8A-TE).

9.0  Using the HSG80 Controller In a Modular Solution

The modular solution consists of the HSG80 controller (single or dual
configurations) installed in a Model 2200 UltraSCSI Enclosure and the drives
installed in either a Model 4214R disk enclosure or a Model 4254 disk
enclosure. The modular solutions must be mounted in RETMA cabinets. The
RETMA cabinets are available in heights of 42U, 41U, 36U and 22U. The Model
2200 enclosure is 4U. The Model 4214R disk enclosure and the Model 4254
disk enclosure are each 3U. This combination allows for several cabinet
configurations.

NOTE

If you wish to use an existing HSG80
controller, it will require the Cache Bulkhead
upgrade for installation of the HSG80 in the
Model 2200.

• For information about how to install the HSG80 controller in a Model 2200
UltraSCSI Enclosure, see the Compaq StorageWorks Model 2200-series
Enclosure User Guide.

• For information about how to install drives in either a Model 4214 disk
enclosure or a Model 4254 disk enclosure, see the Compaq StorageWorks
Enclosure 4200 Family LVD Disk Enclosure User Guide.

• For information about the 9000-series, see the Compaq 9000 Series Rack
Products Reference Guide.
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9.1  Disk Enclosures

The HSG80 controller firmware can address up to 12 disks per SCSI bus.  In
single bus mode this means that 12 of the 14 disks in the model 4214R
enclosure are used. The 2 extra disks can be used for in-cab inventory. The
firmware can see 7 disks on each bus, allowing use of all 14 when configured
with the 4254 enclosure for dual-bus mode. The maximum number of disks
supported by an HSG80 (single or cooperating pair) is 72.  The disk enclosures
can be configured for single bus or for dual bus.

NOTE

The 42xx disk enclosures do not allow daisy
chaining between shelves.

Single-Bus Mode

Disk Enclosures Options/Single Bus Mode Part Number

StorageWorks Enclosure Model 4214 R 103381-001, B31, 291
(Rack Mountable Single Bus Single Power 14 Bay Drive Shelf)

Second Power Supply for 4214R   119826-B21
(Adds a redundant power supply to the 4214R)

Dual Bus I/O Module for Existing 4214R 119829-B21
(Changes the 4214R from a single bus to a dual bus)

NOTE

4214Rs shipped prior to February 28, 2000, may
require the exchange of the EMU and single bus
modules to operate properly with the HSG80.
Check the EMU and I/O modules: if you see a “FB”
sticker the modules are appropriate for the
HSG80. If there is no sticker contact your local
service representative.



Page 20    MA6000 HSG80 Array Controller ACS Version 8.5C Solution Software for IBM-AIX

Dual-Bus Mode

Disk Enclosures Options/Dual Bus Mode Part Number

StorageWorks Enclosure Model 4254 138151-001, B31, 291
(The 4254 includes the redundant power supply and the dual
bus I/O module.)

There is no option available to transform a Model 4254 disk enclosure to single
bus.

SCSI Cables

SCSI Cables are required to be ordered separately for connection of the 42xx
shelves to the Model 2200 enclosure.

 NOTE

 At the time of this release, only the 1-meter SCSI
cable (168256-B21) has been FCC qualified and is
supported.

SCSI Cable Options/Dual Bus Mode Part Number

1M SCSI Cable 168256-B21

2M SCSI Cable 168258-B21

3M SCSI Cable 189505-B21

5M SCSI Cable 400983-005

10M SCSI Cable 400983-010
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9.2 Modular Solution

The Modular Array/Enterprise Modular Array storage systems can be ordered
three ways:

• Predefined models are available that provide a set number of controller
shelves and drive shelves in a Modular Storage Cabinet:

• MA8000: One Model 2200 controller enclosure and three dual-bus Model 4254 disk
enclosures in a 22U Modular Storage Cabinet

• EMA12000 D14: Three Model 2200 controller enclosure and nine dual-bus Model
4254 disk enclosures in a 42U Modular Storage Cabinet

• EMA12000 S14: One Model 2200 controller enclosure and six single-bus Model
4214R disk enclosures in a 36U Modular Storage Cabinet

• EMA12000 Blue: One Model 2200 controller enclosure and three dual-bus Model
4254 disk enclosures in a 41U Modular Storage Cabinet

 NOTE

 The predefined models require the following
options: Controllers, Controller firmware and
drives.

• Configure-to-Order. This allows you to specify the number of controller
shelves and drive shelves desired in a Modular Storage Cabinet.

• Assembly on site. This allows you to order the components separately and
install them in any supported RETMA rack or cabinet.



Page 22    MA6000 HSG80 Array Controller ACS Version 8.5C Solution Software for IBM-AIX

10.0  StorageWorks Command Console (SWCC)

This portion of the release notes provides application information about Version
2.3 of the Command Console HSG80 Client software suite. Command Console
Client, HSG80 Storage Window 2.3 is a feature-rich graphical user interface
(GUI) for StorageWorks HSG80, Fibre Channel controllers.

The Logical View is an accurate representation of your subsystem; however, the
Physical View may not be an accurate representation of your subsystem.

If you plan to use the SWCC with a Fibre Channel switch and the HSG80
controller, first install the SWCC that came with the switch and then install the
SWCC that came with the HSG80 controller.

This section of the release notes covers the Command Console Storage
Manager and CLI Window modules. These modules are referred to within as
“Client”.

10.1 Document Issues

The term “Command Console” can refer to the Storage Window Manager. It can
also refer to the entire Command Console product suite and all of its
components, or simply as “the software”.

In this section, Storage Window Manager, paging, and automatic event
notification issues are presented to cover situations that Command Console
Clients have been installed under an installation that includes a Storage Window
Manager.

Client and Agent are intimately connected in their operation. Although these
release notes are meant to cover Client issues, some Agent-specific issues are
included for completeness.

10.2  More Information

For complete product information on Command Console, see the product’s on-
line Help. Also, for details on the features of the controller software, see the
controller documentation.
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10.3  Installation Notes

Be careful about the order in which you install certain SWCC products. If you
install SWCC from a Switch CD-ROM kit, it may overwrite newer SWCC
components that have been installed with the CD-ROM that ships with this kit.
You should reinstall using the CD-ROM in this kit to ensure that you have the
latest client versions.

Stand-Alone Installations

After doing a stand-alone install of a device-specific Client, exit Command
Console before adding or accessing a system with that type of device.
Command Console will then recognize the installation

SWCC 1.1B Client Will Not Work if Version 2.x Client Was Already Installed

SWCC 1.1b will malfunction if you already have SWCC 2.x on a
Windows NT/Windows 2000 operating system. The Asynchronous Event
Service that comes with SWCC 2.x uses the same port as SWCC 1.1b. SWCC
1.1b can be removed without impacting SWCC or ServerWORKS.

Perform the following to solve this:

1. Uninstall SWCC 1.1b. Ignore the error box that appears.

2. Reboot the computer. The integration for SWCC 1.1b will have been removed.

3. Integrate SWCC 2.x with ServerWORKS.

"There is no disk in the drive" Message

When you install the Command Console Client, the software checks the
shortcuts on the desktop and in the Start menu. If you have Windows NT or
Windows 2000, the installation will check the shortcuts of all users for that
computer, even if they are not currently logged on. You may receive an error
message if any of these shortcuts point to empty floppy drives, empty CD-ROM
drives, or removable disks that are no longer present. Do the following:

1. Ignore the error message by clicking Ignore.

2. Replace the removable disks.
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3. Place a disk in the floppy drive and a CD-ROM in the CD-ROM drive.

4. Click Retry.

10.4  Uninstall Notes

Command Console Client Uninstall Does Not Remove AsyncEventService
Entries

Before uninstalling the Command Console Client, first remove the
AsyncEventService entries. This prevents the computer from sending you
messages during boot time about a service failing to start.

Under Windows NT/Windows 2000, change to the directory to which you
installed the Command Console Client, type the following command and then
press RETURN:

AsyncEventService -remove

Then, remove the Command Console Client.

10.5  Clarifications

This section presents clarifications on the behavior of the software in certain
situations.

Integration Problems with SWCC and Insight Manager

Starting with Insight Manager version 4.23, the HSG80 controller can be
monitored and managed from Insight Manager. Insight Manager includes the
HSG80 controller and its status on the Insight Manager storage display. Insight
Manager can also launch the SWCC HSG80 Storage Window to manage storage
connected to the HSG80 controller.

When the HSG80 Storage Window is opened within Insight Manager, the
Storage Window that supports ACS version 8.4 and earlier is launched. The
Storage Window will work correctly as long as it is used with HSG80 controllers
that have ACS 8.4 or earlier. The HSG80 Storage Window that opens within
Insight Manager does not support ACS 8.5 or later. Undesirable results may
occur if this Storage Window is used with HSG80 controllers that have ACS 8.5
or later.
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Special Windows NT Device Driver Required for Compatibility in SCSI-2
Mode

For local SCSI and network connections, the special HSG80 device driver,
HSZDISK.SYS, must be installed and running properly to connect Client to a host
running Windows NT. The device driver makes HSG80 virtual disks visible to
the host operating system and enables communication between Client, Agent
and the host’s file system.

SWCC Agent Uninstall

The Windows NT or Windows 2000 SWCC Agent may not be completely
uninstalled (that is, the service is not removed) until a system reboots.

Duplicate Client Entries

Duplicate client entries may appear in the Windows NT or Windows 2000 Start
menu. The extra shortcuts can be removed as follows:

1. Click Start>Settings>Taskbar.

2. Click Start Menu>Programs.

3. Click Advanced.

4. Click Program folder.

5. Click Command Console folder.

Remove duplicate entries manually from this folder.
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EMU Status

The EMU status indicators do not reflect the proper status in modular storage
(MA8000, EMA120000). "CLI show EMU" gets "ERROR C000 EMU not installed
or operational" when it may be working correctly.

Event Logs

The event log on the Windows NT or Windows 2000 client may have extra error
message text appended.

Cautions When Configuring from a Configuration File

When reconfiguring a storage subsystem from a configuration file, the program
prompts you to choose whether or not the program initializes your virtual disks.
You must choose the appropriate option or you risk the loss of your data as the
configuration file is loaded and your subsystem is reconfigured.

• Do not initialize virtual disks—Choose this option when your virtual disks
contain valuable user data, and you wish to retain that data. You might, for
instance, need to replace a failed subsystem component such as a
controller or cache module. In this case, your subsystem configuration
must be transferred to the new hardware, but you do not wish to change
any information on your storage devices themselves.

• Initialize virtual disks—Choose this option when your virtual disks do not
contain user data, or when you do not care if the data on them is lost. You
might use this option when configuring a storage subsystem from scratch,
to make it match the configuration in your configuration file.

 Virtual Disk Recovery from a Configuration File

Note that when you delete a virtual disk, the disk’s member drives are all
reinitialized and any user data is lost. You cannot restore the virtual disk’s data
by reconfiguring your subsystem from a configuration file. A configuration file
contains only information about the structure of a virtual disk and does not
contain the disk’s data itself.
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Warning Message Windows

The controller software responds to problems in parsing and executing
commands from Client and Agent by returning a message window entitled
“Warning”. The content of such messages may contain such indications as
“Command Execution Error,” along with pertinent detailed information.

These messages are simply passed through for display by Client and Agent and
are normally associated with problems in the controller.  However, sometimes
“Command Execution Error” does indicate a problem with SWCC.

Virtual Disk Maximum Capacity

The maximum capacity of RAID-based virtual disks is determined by the
capacity of the smallest member, not the largest.

• The maximum capacity of RAID 0 virtual disks is equal to the number of
members times the capacity of the smallest member.

• The maximum capacity of RAID 1 virtual disks is equal to the capacity of
the smallest member.

• The maximum capacity of RAID 0+1 virtual disks is equal to the number of
members in one stripe times the capacity of the smallest mirrorset
member.

• The maximum capacity of RAID 3/5 virtual disks is equal to the number of
members minus one times the capacity of the smallest member.

Local Client/Agent Network Connection

To create a local connection to take advantage of Agent’s event notification
features, you can run both Client and Agent on the same Windows NT host
machine and connect them using a network connection. No special installation
instructions are necessary to implement this type of connection. Install each
component as if Client were to run on a system remote from the host machine.
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Note that, because Client only runs on Windows NT and Windows 2000
systems, and Agent runs on Windows NT, UNIX-based systems, and OpenVMS,
you can only implement this type of connection on a Windows NT system.

Note also that you cannot use Client with a local connection of either type while
an Agent is running on the local machine.

Operating System Considerations

Client provides a graphical interface that replaces your controller’s CLI
interface. It cannot, however, perform all operating system configuration
necessary to make your subsystem’s virtual disks visible to the user in the
operating system.

When you create or delete virtual disks using either the CLI or Client, you are
adding or removing “disks” in the subsystem in a manner similar to plugging or
unplugging physical disk drives on the host bus. In either case, there are certain
operating system configuration actions you must perform to make these
“disks” visible or invisible to the operating system’s file system.

 Windows NT/Windows 2000 Configuration

On a Windows NT/Windows 2000 host, after you create or delete a virtual disk
using Client (or the CLI), you must perform the following steps to properly
configure the file system to recognize your changes.

1. Boot the host system. This action has the effect of forcing the Disk Administrator to
recognize added virtual disks as raw disks, available for use. It also notes that deleted
virtual disks are no longer present.

2. Create file system partitions on your disks. When you create a virtual disk in the controller,
you have the option to partition it at the controller level in any way you wish, as long as
you create at least one partition per disk. Each of the controller-level partitions you create
becomes a virtual disk, visible to the host. In Disk Administrator, you must partition these
newly added virtual disks at NT’s file system (NTFS) level.

3. Once you have partitioned your drives in Windows NT/Windows 2000, the file system
assigns each drive a unique drive letter. Make a note of the drive letters assigned.

4. Format your disks—You must format each newly added disk.

5. Start the Agent Configurator by double clicking its icon in the Command Console Start
Menu group.
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6. Navigate through the menus until a popup appears, prompting you to rescan your
subsystems. Click Yes to perform the rescan and display a list of subsystems.

7. Make sure that the access device you’ve been using for your subsystem still exists. If you
inadvertently deleted it, you must assign another device in its place. If no access device
exists, Client cannot communicate with your subsystem unless the CCL is used.

8. Click the Next button until you can exit the configurator.

9. Select the Services option in the Windows Control Panel.

10. Scroll down to highlight the Steam entry.

11. Click the Stop button and wait for a prompt indicating that the service is halted.

12. Click the Start button and wait for a prompt indicating that the service is started.

13. Exit Control Panel.

14. Windows NT/Windows 2000 now recognizes any changes you may have made in your
virtual disk configuration.

 UNIX-Based Configuration

On a UNIX-based host and after you create or delete a virtual disk using Client
(or the CLI), you must perform the following steps to properly configure the
UNIX file system to recognize your changes.

1. Reboot the host system—This action has the effect of forcing the file system to recognize
added virtual disks as raw disks, available for use. It also notes that deleted virtual disks
are no longer present.

2. (Optional) Create file system partitions on your disks—When you create a virtual disk in
the controller, you have the option to partition it at the controller level in any way you
wish. Each of the controller-level partitions you create becomes a virtual disk, visible to
the host.

3. Afterward, if you desire, you can partition these newly added virtual disks at UNIX’s file
system level. Use the appropriate commands for your operating system version to perform
this task. Once you have partitioned your drives in UNIX, the file system assigns each drive
a unique drive identifier.

4. Stop and Restart the Agent—Using the Agent configuration script, you must stop and
restart the Agent running on your UNIX host, using the configuration program. In the
program, you must choose the option to create a new storage.ini file. This action updates
the Agent to recognize any virtual disk changes you have made.
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Enabling Subsystems in Windows 2000 Agent Configurator

In the Step 3 dialogue box of the Windows 2000 Agent Configurator, a check
box entitled “Subsystem Enabled” has been added. If this box is not checked,
the program configures the storage.ini file such that the subsystem selected in
the dialogue box is invisible to the host. If the box is checked, the subsystem is
visible. The default state for all subsystems is “enabled.”

Case Sensitivity in Client, Host, and Storage Subsystem Names

In configuring Command Console for network operation, you must enter names
or IP addresses to identify your hosts, storage subsystems, and Client systems.
If you use names (as opposed to IP addresses) the names in Client and Agent
must be consistent to allow the programs to communicate with each other. This
section discusses issues of case sensitivity associated with name entry in
Client and Agent. This information does not apply when you use IP addresses.

In the connection dialogues in Client, you are required to enter host names, and
you also have the option to enter specific storage subsystem names. In the
Agent installation and configuration programs, you are required to enter Client
and storage subsystem names.

 Host and Subsystem Names in Client

Enter host and subsystem names in Client without regard to case.

 Subsystem Names in Agent Installation/Configuration Programs

Enter subsystem names in the Agent installation/configuration programs
without regard to case.

 Client Names in Agent Installation/Configuration Programs

For Windows NT/Windows 2000 and UNIX-based Agents:
Enter Client names in the installation/configuration programs without regard to
case.
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ServerWORKS Connections

You can manually configure any Agent to send SNMP traps to a host running
Compaq Computer Corporation’s ServerWORKS by editing the client.ini file. Edit
the file to include the ServerWORKS host name and SNMP notification.

Running Client Via Network Connections

You can operate Client over PPP, SLIP, or RAS network connections. Be aware
though, that some restrictions on features exist. See Operating Constraints.

Display in VGA Mode

There are numerous issues involving the use of Client on a system with
standard, VGA resolution. The Storage window requires a minimum amount of
screen space to properly display its contents. When you use VGA display
resolution, screen space becomes more limited. It is highly recommended that
you use Client with a minimum of SVGA (800x600) display resolution.

If you must use VGA resolution, consider the following suggestions:

• You may not be able to see the scroll bars on the bottom of the display. You
can use the Storage window’s menu settings to remove the toolbar from
the display to make room for the bottom scroll bars.

• If you are using Client with a 24-device, high-availability enclosure, it may
be easier to configure the subsystem if you set the system type to Generic
for configuration purposes. Return the setting to High-Availability 24-
Device Pedestal for monitoring and viewing.

Tuning Fault Notification

For faster fault notification, remove any unused host system names in the
client.ini file for each of your Agent programs. Inactive systems may force
timeouts that slow Client response to your commands.

Also, ensure that you are not using event notification while using RAS
connections. See “Delayed Event Notification on RAS Connections” in the next
section, for more details.
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Paging and Event Logging Continues After Client is Terminated

In certain situations, you may experience continuing paging and event logging in
response to subsystem faults, even though Client is not running. This behavior
is normal and a result of paging and event logging activity started by Client
when it was running.

Client’s Asynchronous Event Service (AES) module runs as a Service, and
continues to run, even after Client itself has terminated. The AES module
communicates with Agents whenever it is running, and activates paging and
event logging when a subsystem event occurs.

In Windows NT or Windows 2000, to terminate paging and event logging after
Client has been closed, go to the Services section of Control Panel, select the
“AsyncEventSvc” Service, and stop it.

Setting Up Pager Notification

You may need to tune the pager notification feature for proper functioning with
certain pager systems. The pager feature supports both alphanumeric and
numeric pagers and allows for notification of multiple pagers. You can select
multiple pagers to be notified for multiple storage subsystems within different
blocks of time. You can also temporarily disable any pager.

Use the following procedure to set up and tune the pager notification system:

1. In Storage Window Manager, select Options>Event Notification>User Profile.

2. Click on New and enter the name of the person to be notified.

3. Select the Pager folder and enter the person’s pager number, along with any prefixes
required to reach the outside phone system. It is good practice to place delays as commas
(,) after any exchange switch that might occur. Each comma results in two seconds of
delay. An example is: 8,,1, 800,5551212. In this example, there is a 4-second delay
between the 8 and the 1.

4. Select the Alphanumeric box if the paging system supports it. Leaving the box blank
results in numeric paging only.

5. Click on the Enabled box to enable paging to this person.



Release Notes   Page 33

6. Enter the start and end times that this person is available for paging. If you want 24 hour
coverage, enter a start time of 0:00 and an end time of 24:00. You must enter a time
period for paging. Leaving the start and end times at 0:00 has the effect of canceling
paging for this person.

7. Close the User Profile menu.

8. Select Options/ Event Notification/Notification List, to list all of the persons to be notified
as a named group. (Later, you will be able to assign these groups to individual systems.)
You can enter a description along with the name to state such information as times and
subsystems that this person supports.

9. If you’re using numeric paging, you can view the failure codes that are used under
Options>Event Notification>Pager codes.

10. To set the communications port and baud rate for the pager modem, select
Options>Preferences to view the Event Notification Preferences menu. You can also set
the subsystem polling interval on this menu.

11. You can establish paging on three separate levels: You can establish paging on all levels
on any combination of levels.

a) My Enterprise – Notifies all notifications list listed here for problems on all systems
and subsystems

b) Highlight “My Enterprise” in the Storage Window Manager and then select
/File/Properties/Event Notification from the menu. Clicking on the Notification List
box will list all of the lists you have created. Choice the list for persons that should
be notified in case of a failure on any system.

c) System Level – Notifies all notifications lists listed here for problems on the specific
system and all its subsystems selected

12. Highlight the desired system name in the Storage Window Manager and then select
Start>Programs>File>Properties>Event Notification. Clicking on the Notification List box
will list all of the lists you have created. Choice the list for persons that should be notified
in case of a failure on any subsystem of this specific system.

13. Subsystem Level - Notifies all notifications lists listed here for problems on the specific
subsystem selected
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14. Highlight the desired subsystem name in the Storage Window Manager and then select
Start>Programs>File>Properties>Event Notification. Clicking on the Notification List box
will list all of the lists you have created. Choose the list for persons that should be notified
in case of a failure on this specific subsystem.

15. You have completed the paging notification setup. You may find that you will have to
make modifications in order to work with various paging systems throughout the world.

Operating Parameters of Partition Virtual disks

Keep in mind that virtual disks based on partitions on any container are all
closely related. They all share the same target and operating parameters of the
container. If you change any of this information for one partition on the
container, it automatically changes for all the partitions on that container.

10.6  Operating Constraints

This section describes the operating constraints for the software.  An operating
constraint is a limitation placed on the operation of the controller by the nature
of its design.  Keep these constraints in mind, to avoid problems and to help you
to get the maximum performance from your controller.

Compatibility Among Product Versions

CAUTION

Pay particular attention to the instructions below
for uninstalling existing Client and Agent
components from your local system. Failure to
remove existing components before installation
may result in Windows Registry corruption.

Version 2.1 software components are not compatible with version 1.1
components, and operation with mixed components is not supported. You must
uninstall your version 1.X software, including Clients and Agents, before you
install version 2.1 components. Use the instructions that came with your
version 1.x software to uninstall it.
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Before you install your new Client software, you must uninstall any existing
version 2.1 CLI Window. Use the “Add/Remove Programs” feature or the
instructions that came with your existing software to uninstall it. The installation
program will install a newer CLI Window version in your old version’s place.

Note that, in configurations with existing version 2.x components, you need not
remove the Storage Window Manager components. You also need not remove
any Storage Window components other than one matching the one you wish to
install. The installation program will install your new Client Storage and CLI
Windows seamlessly under your existing Storage Window Manager.

Failover Mode Set in CLI

Client is intended to be used to configure and monitor your storage only, and
there are some functions available in the CLI that are not available in graphic
form in the GUI. If you wish to use your controller’s multiple-bus failover mode,
you must enable and control that function via the CLI.

Also, if you wish to use virtual disk preferencing in multiple-bus failover mode,
you must set your virtual disk preferences via the CLI when you set the failover
mode.

10.7  Connection Limitations

Local SCSI or serial connections are only available with standalone Storage
Windows. You cannot use the Storage Window Manager to connect locally to a
subsystem.

Some Features Dependent Upon Connection Type

Because of the nature of the connections you can use between Client and your
subsystems, the features available with each connection type vary slightly.
Some connection types impose limitations on Client’s features, as noted in
Table 4.
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Table 4.  Feature Limitations

Feature

Connection Type

Create
virtual disk

Delete
virtual disk

Fault
Events:
Client
Visual

Notification

Fault Events:
Paging

Notification

Windows
NT and

Windows
2000 Fault

Events:
Event

Logging

Email
Notification

(UNIX/VMS
only)

Local Serial
Connection
(Storage Window
Manager and
Agent not used)

Supported Supported Supported Not
Supported

Not
Supported

Not
Supported

Local SCSI Bus
Connection
(Storage Window
Manager and
Agent not used)

Supported Supported Supported Not
Supported

Not
Supported

Not
Supported

Local Network
Connection
(Client and Agent
running on the
same host)

Supported Supported Supported Supported Supported Supported

Remote Network
Connection
(Client running on
a PC remote from
Agent on a host)

Supported Supported Supported Supported Supported Supported

RAS Connection
(Client running on
a remote PC with
a dialup network
connection)

Supported
but not
recommend
ed.
Followup
operating
system
configuratio
n cannot be
performed
remotely

Supported
but not
recommend
ed.
Followup
operating
system
configuratio
n cannot be
performed
remotely

Supported
reliably only
while RAS
intact. Some
events may
be missed
while dialup
connection
is broken.

Supported
reliably only
while RAS
intact. Some
events may
be missed
while dialup
connection is
broken.

Supported
reliably at
host end
only. Some
events may
be missed at
Client end
while dialup
connection
is broken.

Supported
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Delayed Event Notification on RAS Connections

Visual fault notification, paging, and event logging may be delayed significantly
in situations where RAS connections are used for multiple Clients. An Agent
with multiple Clients in its client.ini file must poll each Client whenever a fault
occurs. Any Clients not currently network-connected significantly delay this
process, because Agent must wait for their connections to time out before
moving on to the other Clients.

To avoid this situation, set the notification_method parameter for each Client in
the client.ini file to “0”, to defeat event fault notification.

CLI RUN Commands

Do not issue RUN commands in the CLI Window.  Use only a maintenance
terminal connection to issue RUN commands.

Creating Partition Units Across Targets or Ports

Be aware that the name you pick for a unit assigns it to a particular host bus
target. If you create a unit from free space on a device, the program forces you
use a unit name that puts the unit on the same host target as the other
partitions on the device.

On dual-port controllers, partitions on the same device that are assigned to
different host ports are not supported.

No Code Load in Multiple-Bus Failover Mode

The controller code load feature is not functional in multiple bus failover mode
for non-OpenVMS network connections. Do not attempt to update your
controller’s software in this mode.
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Maximum Members Dependent Upon Virtual Disk Type

The maximum number of members allowed in a RAID-based virtual disk is
dependent on the disk type. However, concatenated sets are now available for
JBODs, stripes and RAID 3/5 sets.

• JBOD virtual disks—maximum of one member. JBODs may now be
expanded to two disks if concatenated sets are used.

• Striped virtual disks—maximum of 24 members

• Mirrored virtual disks—maximum of 6 members

• Striped mirrored virtual disks—maximum of 48 members

• Parity virtual disks—maximum of 14 members

Maximum Number of Active Connections Limited

The controller maintains a table of host port connections that can contain up to
64 named connections. Only 8 of those connections can be active (that is, “on
line”) at any time, however. Client shows only those connections that the
controller recognizes as “on line”.

Avoiding Problem Situations

In certain situations and under specific conditions, you may experience unusual
behavior with the software.  This section presents information to help you avoid
such situations and to recover from them if they occur.

Enable Read-ahead Cache Before Enabling Write-back Cache

The controller requires that read-ahead cache mode is enabled before you can
enable write-back cache mode.

Incomplete Scans Cause Connection Loss

For proper display of subsystem status, Client performs a “scan” to collect
information about your storage subsystems. The program displays scan
progress screens while the process occurs. In some, rare situations, you may
experience incomplete scans or scans that appear to hang. In these cases, the
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likely cause is that Client has lost its connection with the virtual disk it was
using for communication with your subsystem.

This problem may show up with either local SCSI or network connections.

To remedy this situation, you must first restart both of your controllers, followed
by restarting Client and Agent. If the system still does not operate properly, you
must reboot your host system. If your host is running Windows NT or Windows
2000, you must ensure that the special device driver, HSZDISK.SYS, is installed
and running properly after it is booted.

Mirrored Cache Mode Not Retained After Configuration Restore

If you restore your controller configuration from a configuration file, the
mirrored cache setting may not be properly enabled. You must restore the
mirrored cache setting manually, using a CLI Window.

Error Message on Exiting Storage Window

Under certain conditions, when you exit a Storage Window, you may experience
an “Illegal Operation Error” message. You may ignore this message.

Inappropriate Error Message on Device Delete

If you select a disk, then chose Device/Delete, a dialog box may appear, asking
“Are you sure?”. If you choose the “NO” option, the message “Nothing selected
to delete!” is displayed. You may ignore this message.

Storage Window Corruption After Making/Removing Spare Device

If you select a disk and make it a spare (using either menu or context menu
options), then remove the device as a spare, some information in the Storage
Window may be left corrupted. To reconstruct the window, you must exit the
window and open a new one.

Cache Policy Not Shown in Controller Properties Sheet

The controller cache policy may not be properly shown in the controller
properties sheet. The field may be blank. You must use a CLI Window to obtain
the cache policy setting.
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Incorrect Capacity Shown in Add Virtual Disk Wizard

In some circumstances, in Step 3 of the Add Virtual Disk Wizard, if you specify
a capacity greater than the available disk capacity, an error message results. If
you back up to Step 2 of the Wizard and return to Step 3, the correct capacity is
then displayed. An attempt to move to Step 4 of the Wizard at this point,
however, results in the same error message, even though the correct capacity
is shown.

To complete your virtual disk, you must exit the Wizard and attempt to recreate
the virtual disk.

Storage Window Corruption While Deleting a Virtual Disk

In some circumstances, if you delete and confirm deletion of a RAID-based
virtual disk, a “Subsystem Connection Status” window may be displayed, and
the Storage Window goes blank. The Storage Window may remain blank for
several seconds until the  “Subsystem Connection Status” window disappears.

Application Errors When Restarting Agent

You may experience an “application error” error when attempting to restart
Agent after manually changing the Agent configuration files. Either of the
following issues may be the cause:

• The client.ini file must end with a carriage return. If any other character
terminates the file, it may cause an application error.

• The storage.ini file must not end with a carriage return. If a carriage return
terminates the file, it may cause an application error.

False Restart Message on Agent Installation

When you first install a Windows NT/Windows 2000 Agent, and you modify
more than one configuration parameter, the installation program may prompt
you with a message indicating the Agent must be “restarted”, even though it
has not yet been completely installed. You may ignore this message, and you
must respond to the subsequent prompt, “Would you like to start the Agent
service now?” by answering “Yes”.
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Client Access Changes Not In Effect

After manually editing or changing the Agent client.ini file with a configurator
program, you may notice that your Clients’ access has not changed. To place
your changes in effect, you must restart Agent after editing any of the Agent
configuration files.

Reconfiguration After Controller Replacement

If you replace either of the controllers in your subsystem, you must reconfigure
your Agent storage.ini file to match the serial numbers of the new hardware.
See your Agent documentation for details on reconfiguring your storage.ini file.

Storage Window Won’t Open

If you cannot open a Storage Window from the Storage Window Manager or in
standalone mode, the client.ini ACCESS_ALLOWED parameter for your Client is
probably set to “0”, disabling Storage Window access. Use the Agent
configuration script or edit the client.ini file to enable access to the subsystem.

 Configuration File Deleted on Reinstallation or Upgrade

Save a copy of the current swcc2.mdb file to another directory if you intend to
reinstall or upgrade Client. If you uninstall the program, you will delete the
swcc2.mdb file. This file contains your configuration of host systems and
storage subsystems used in the Navigation Tree.

To reinstate your current Navigation Tree configuration after installing a new
version of Command Console, copy your saved swcc2.mdb file back to the
directory to which you installed Command Console.

Invalid Network Port Numbers During Installation

During Client or Agent installation, you may experience an error if the
installation program cannot find an acceptable pair of network port numbers.

Your Client uses Windows sockets (sometimes called “network ports”) to
communicate with its Agents. The socket numbers at the Client and Agent ends
must match for network communication to occur.
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In Windows NT/Windows 2000, the socket numbers are assigned in the
services file in the \winnt\system32\drivers\etc subdirectory. In UNIX-based
systems, the socket numbers are assigned in the services file in the /etc
subdirectory. In the unlikely event that you experience a conflict with the socket
numbers, you may edit the file manually.

There are two default socket numbers, one for Command Console (4998) and
the other for the HS series Client and Agent (4999). If you are installing either
Client or Agent and these numbers are already taken by another application, the
installation program prompts to warn you that you must choose another pair.

To select another pair for Client, open the file containing the sockets in an ASCII
editor, after you have installed Client. Pick two numbers above 1023 that are
not already used in the file, and add the following two lines:

spgui       number1/tcp # StorageWorks® Command Console
spagent     number2/tcp # StorageWorks® Command Console

Note that the port numbers that you select must match the port numbers used
by all of the Clients to which you wish to connect your Agent.

Network Port Assignments for UNIX-Client/Server Systems

A UNIX host may use Network Information Services (NIS) to serve the services
file containing its network port assignments.

Agent must use the services file to determine which network ports to use.
Because of this requirement, you may need to configure your system so that
Agent can access the proper services file.

You have two options to prevent a conflict between the two possible locations of
the services file. See the Agent user guide for your particular Agent for more
information.

Error on First Attempt to Make Connection

You may experience a system error such as a “Command Execution Error” on
your first attempt to make a network connection using the Storage Window. If
this happens, try the connection again, and it will succeed.
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Client Hangs If Virtual Disk Deleted

If Client is monitoring a particular subsystem, and you delete the virtual disk
being used to communicate with that subsystem, the program may hang. To
delete the virtual disk Client is using for communications with an Agent, you
must first reassign another virtual disk as the communications LUN, using the
Agent configurator.

If you are using the CCL as your communications LUN, and you disable it, Client
may lose its connection with your subsystem. If you wish to disable the
communication LUN, you must first reassign another virtual disk as the
communications LUN.

Missing Tabs in Search Menu in Help

When you select the Search button in Command Console Help, Windows Help
may not display an Index or Find Tab.

To prevent this problem, delete any hidden files with a .GID extension that are in
the Command Console directory. The WinHelp engine uses .GID files to
construct the Index and Find Tabs. If the files are corrupted, the engine may not
display one or both of the tabs. Deleting the files causes the engine to
reconstruct the .GID files.

Invalid Cache Errors

Your controller module, cache module, and subsystem devices all contain
configuration information used to keep their activity synchronized. This data is
called metadata. The controller software reports an invalid cache error on the
affected controller when there is a mismatch between the metadata in the
controller module and a cache module containing unwritten data. This
mismatch can result in loss of the unwritten cache data if the error is not
cleared properly.

CAUTION

Use extreme care in responding to the Command
Console invalid cache error prompt.  If you
inappropriately instruct the program to delete
unwritten cache data, you may lose valid user
data.
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Client displays a message and prompt box when an invalid cache error occurs.
You must tell the program whether or not to delete unwritten cache data as the
error is cleared. If you are not familiar with the proper treatment of unwritten
cache data, see the information in the on-line Help documentation under the
topic “Invalid Cache Errors.”

Connecting Via the Host SCSI Port

Client may indicate that it cannot find your subsystem if you attempt to connect
via the host SCSI port by using Windows NT/Windows 2000 in either of the
following situations:

• A StorageWorks controller subsystem is connected to the host, but the
subsystem has no virtual disks configured on it in SCSI-2 mode with
CCL disabled.

• A StorageWorks controller subsystem is not connected to the host.

If you are using SCSI-2 mode and Windows NT/Windows 2000, you
must disable the Command Console LUN and create a virtual disk by
using a serial connection. For more information on the Command
Console LUN, refer to the Compaq StorageWorks Command Console
V2.3 for User Guide.

Note that because Agent uses a SCSI host bus connection to its subsystems,
the same rules mentioned above also apply.

Communications Failure on Power Up with Low Batteries

If the battery in your cache is discharged when you power up the controller, the
controller may produce an invalid cache error. If you are using Client as your
controller interface at that time, the error may prevent communication with the
controller. In this case, the controller status bar in Client changes to yellow, and
the program displays a window containing error information.

To clear the error, you must exit Client and use a normal controller maintenance
terminal to issue the CLEAR ERRORS INVALID_CACHE command before you can
use the controller. See your controller documentation for instructions on use of
the CLEAR ERRORS INVALID_CACHE command.
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If the battery remains low, the invalid cache error may reappear. In this case,
you can operate your controller with reduced capability, or you can change its
cache policy to get around its built-in battery protection, although at some risk
to your data. Refer to your controller documentation for details on its cache
policy controls.

After you have cleared the invalid cache error, you can use either a normal
maintenance terminal or Client as your controller interface.

Lost Connections Cause Invalid or Missing Fault Displays and Event
Logging

Client receives notification for most types of changing subsystem fault
conditions on the next monitor interval after they occur. You may experience
invalid or lost notifications in situations in which Client’s connection with its
subsystems is broken. Any Windows NT/Windows 2000 event logs that might
have occurred while the connection was broken are also lost.

If the connection between Client and its subsystems is broken for any reason,
Client may continue to display faults that are cleared while the connection is
broken. Similarly, faults that occur while the connection is broken are not
displayed at all.

To avoid lost fault indications, make sure that Client’s connections with its
subsystems are monitored and maintained. To reestablish a connection with a
storage subsystem, you must exit and restart Client.

Broken connections can occur for a variety of reasons:

• For RAS connections—It is the nature of a RAS connection that it is not a
full-time connection. Events that occur during a period when the RAS
connection is not made are not logged to Windows NT’s/Windows 2000's
event logging facility.

• For serial controller connections—Bad or missing serial cable. To repair
this situation, plug in or replace the cable.

• For host port SCSI connections—Bad or missing SCSI host cable, no LUNs
configured on controller on Client startup.
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• For network connections—Agent missing or not running, network
discontinuity, Agent not properly configured for your Clients.

• THIS controller halted, reset or hung—To repair this situation, restart or
replace THIS controller.

• The virtual disk being used for communications with the storage
subsystem is no longer available.

No Agent Notification Causes Invalid or Missing Fault Displays

For some types of faults, Agent does not send Client notification of changes in
status as they occur. Client displays whatever fault information it last received.
Following are three situations in which a fault can occur without immediate
display in Client:

• The OTHER controller fails or is shut down.

• A cache battery on either controller fails or goes low.

• A cache module fails.

• A fan fails.

• A power supply fails.

In all of these cases, you can get current status by viewing the subsystem in
question using the REFRESH option in the View menu.

Manual Restart Required in Some Situations

In some situations in multiple-bus mode, both controllers must be restarted to
properly continue subsystem operation. Usually, the software performs this
function automatically. If, however, only one controller in a dual-redundant pair
restarts, you must manually restart the other controller.

CCL Recognition

The Windows NT/Windows 2000 Agents can now recognize a CCL. The CCL
cannot be assigned a drive letter because it is a logical device and must be
recognized by its physical drive number. The Windows NT/Windows 2000 x86
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Agents will recognize both device names (a-z) and physical drive numbers. The
disk administrator can be used to find the associated drive number for any of
the recognized devices.

Reservation Error Message

The Agent application, and other applications which access RAID storage
through SCSI, will get a reservation error if a device is reserved by one host and
another host attempts to access the same device. When this occurs, a generic
I/O error will be logged.

Reservation Conflict

Agent will discard reserved LUNs from its list of devices to be statused. The
reservation conflict will be recorded for each reserved LUN in the system error
log. A notification will appear in the log for each LUN reserved. In addition to the
system’s binary error log (Tru64 UNIX), an error message will also be recorded
in the daemon.log file. An example of the error message is “Device lunName is
reserved and cannot be statused by steamd." This only applies to Agent during
its current run. If Agent is restarted without either a) releasing the reservation or
b) rescanning the bus, the reservation conflict will be recorded again each time
Agent is restarted.

For prior Agent releases, to avoid filling the binary error log, Agent must be
stopped and restarted with bus scan enabled. Agent will not record the
reserved LUN in the storage.ini file, and will not status the reserved LUN.

Multi-agent Functionality

With the current Agent and the direct SCSI connect Client, several Agents and
direct connect Clients can talk to the same controller. Only one will access the
controller at a time, with the others being blocked until the current request is
serviced. The multi-agent functionality will work with any controller with ACS
version 8.5 and above. This functionality is provided by the controller which the
Agent software takes advantage of.

Problems will still be encountered if running in a heterogeneous environment,
for example, running multiple agents or communicating with a combination of
HSZ70 and HSG80s. It is recommended that only one Agent be running in such
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a heterogeneous configuration. The multi-agent functionality is not available in
the Novell Netware Agent.

Switching SCSI Modes

When switching HSG80 controllers from SCSI-3 to SCSI-2 mode, the host
system should be rebooted after the change is made. This will clear any
unclaimed SCSI-3 CCL devices from the system. Failure to clear devices can
cause erratic Agent behavior or crash the NT system (BSOD). It is also
recommended that you reboot when changing from SCSI-2 to SCSI-3 mode.

Add Virtual Disk Wizard Cache Functionality

The Add Virtual Disk Wizard allows you to try to add a unit that has readahead
cache enabled while read cache is disabled. This is an invalid action. The
controller will not allow the “add unit” to execute. The result is a storageset
without an attached unit. This “orphaned” storageset may be used to create a
new unit by returning to the Add Virtual Disk Wizard and adding a unit of the
same redundancy level as the failed unit.

Ensure that you do not check Enable readahead cache if Enable read cache is
unchecked. Refer to Step four of the Add Virtual Disk Wizard.

Add Virtual Disk Wizard – Partitioned Units and Ports Functionality

The Add Virtual Disk Wizard allows you to choose a port when adding a unit
based upon a partitioned set that is different from the port of a current unit that
is using the same partition.

Ensure that you use a LUN ID that corresponds to units that have already been
used for a partitioned storageset. For example, if a unit using a partitioned set
has a LUN ID below 100 (e.g., D55), then the subsequent units should also be
below 100. Likewise, if a LUN ID is 100 or above, subsequent LUN IDs should
also be above 100.

LUN ID is set on Step 4 of the Add Virtual Disk Wizard.

NT Agent CCL Access Device Recognition

For ACS 8.5 in SCSI-3, it is possible to have multiple CCLs based on the unit
offsets. Agent picks the last of the set as the access device. The CCLs will not
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appear in the disk administrator, but are visible in the registry with their port,
target, and LUN. The CCL will show as CCLp:b:t:I, each with a different target
number (port bus target LUN, e.g., CCL2:1:1:0) in the storage.ini file.

In SCSI-2, you will only get one CCL, which is presented as an offline device in
disk administrator. This CCL will show as “PhysicalDrive#” in the storage.ini
file.

Host Non-descriptive Error Message

If the host machine running the Storage Window is not in the client.ini file of an
Agent and attempts to access that Agent, a non-descriptive error message is
returned. For example, “Cannot establish communication with ‘77FORD’ ”.
[Socket message is incorrect type.]

Multiple Connections in Controller Properties Connections Tab

When paging through more than 8 connections in the Controller Properties
window Connections tab and then pressing the Previous button to return to
previous pages, some of the host id and adapter id labels may disappear. This
will not affect functionality.

Selecting Disk Drives When Creating Snapshots

When creating a snapshot, if you select disk drives of different sizes, Storage
Windows reports the size erroneously. Storage Window adds all selected
devices together for selected capacity. The selected capacity is actually the
smallest drive multiplied by the drive quantity selected. Storage Window allows
you to proceed if inadequate storage is selected. If you select drives of the
same size, this feature functions properly. If you select drives of different sizes,
you should calculate the selected storage by multiplying the smallest drive by
the quantity of drives selected.

Client Domain Network Server (DNS) Setup Application Error

You must ensure that your client DNS is set up correctly. In some situations,
Storage Window gets an application error if the Host of the Agent exists but
cannot be reached directly by the Client machine.
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Expand Option Not Implemented

The Expand Unit option is not implemented in ACS version 8.5.

Agent Failure using Multiple Storage Windows

If the Agent fails while you have multiple Storage Windows connected to
different subsystems, you may not be able to close the Storage Window. If this
occurs, use the Windows Task Manager to close the Storage Window.

10.8  Command Console Client Troubleshooting

Authorization Error when Adding the Server to the SWCC Storage Window
Manager

If you receive an authorization error when you add an agent system to the
Storage Window Manager, your client system may be missing from the Agent’s
list of client system entries. If you have more than one type of Agent installed on
that agent system, the name of your client system must be on each Agent’s list
of client system entries.

Help Files Still Appear After Uninstall

After you have uninstalled a storage subsystem Client, its help files will still
appear. Delete the CCONSOLE.GID file, which may be hidden (Windows
Explorer>View>Options>View). This file will regenerate the next time you use
the Client's help files.

Authorization Error When Adding an Agent System

If you receive an authorization error when you add an agent system to the
Navigation Tree, your client system may be missing from the Agent’s list of
client system entries. If you have more than one type of Agent installed on that
agent system, the name of your client system must be on each Agent’s list of
client system entries.
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Increasing Screen Space for the Fabric Windows and Storage Windows

Run the Client on a monitor that has a minimum super VGA (SVGA) (800X600)
display resolution. The Fabric Windows and Storage Windows require a certain
amount of screen space to properly display their contents. When you use a VGA
display resolution, screen space becomes more limited. If you must use a VGA
resolution, select the Auto Hide check box in the Taskbar Properties window to
increase screen space for the Fabric Windows and Storage Windows.

Invalid or Missing Fault Displays and Event Logs

Invalid or lost notifications may occur when the client system’s connection with
a subsystem is broken. The client system receives notification for most
changing subsystem faults at monitored intervals. This means that if the client
system is no longer notified of subsystem faults, then changes to that
subsystem will not be displayed in the client system’s Navigation Tree, Storage
Window (if applicable), Fabric Window (if applicable), and Event Viewer.

For example, while client system’s connection with a subsystem is broken, you
will not receive event logs pertaining to that subsystem, except to notify you
that the connection is severed.

The following list provides the reasons for broken connections. After you have
fixed the physical and/or software problem that is listed below, you will need to
close and reopen the Storage Window pertaining to that subsystem to obtain its
latest status.

• RAS connections -  Remote Access Service (RAS) connections are not full
time. When there is no RAS connection, events are not logged to the
Application Log of Event Viewer.

• Serial controller connections - There may be a bad or missing serial cable.
To repair this situation, replace or plug in the cable.

• Network connections - Agent may be missing or not running.

• Network connections - There may be network discontinuity.

• The Agent may not be properly configured for a client system.

• If your setup includes a controller, the controller may have halted, reset or
hung. To repair the situation, restart or replace the controller.
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• If your setup includes virtual disks, the virtual disk being used for
communicating with the subsystem is no longer available.

Pager Notification Continues After Exiting the Command Console Client

You may have noticed continuous pager notification in response to subsystem
faults, even though you have exited Command Console Client. This behavior is
normal.

AES runs under Windows NT and Windows 2000 as a service. It continues to
run even after you have exited Command Console Client. AES communicates
with Agents, and it activates paging when a subsystem event occurs.

To stop pager notification, stop AES. For information on how to stop AES, see
“About the Asynchronous Event Service” in Chapter 2.

Some Graphics Do Not Scale Well with Large Fonts

It is recommended that small fonts be displayed when using the SWCC Client
software on Windows NT or Windows 2000. Some of the graphics do not scale
as well when large fonts are used.

Starting Client from the Command Prompt

To start the Client with network connections from the command prompt, enter
the following at the command prompt on the client system:

\path_to_client_directory\swcc.exe -d your_host_system  your_host_subsystem

where -d your_host_system your_host_subsystem  is an optional set of
parameters that enables you to specify a system and a subsystem to start
Client.

For example:

C:\>\Program Files\Compaq\SWCC\swcc.exe –d hostsystem subsystem

If you specify these parameters, Client opens with the system selected and the
subsystem displayed in the Storage Window, in the Fabric Window, or in a Web
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browser. If Client is not already aware of the system and the subsystem, it adds
them to the Navigation Tree.

10.9  Troubleshooting Connection and Access Problems

SWCC is a TCP/IP socket-based application. As a result, SWCC requires that
each node running a SWCC Client or Agent must have access to a valid hosts
file or Domain Name Service (DNS) server. The valid hosts file must include at
least the system itself and any other systems running a SWCC Client or Agent
that it will connect to.

Dynamic Internet Protocol Address Allocation Not Supported

SWCC will not work properly if the client systems or agent systems are
obtaining an IP address dynamically. This is because the Dynamic Host
Configuration Protocol (DHCP) is not supported. RAS servers and IP tunneling
servers are supported only if they are configured to nondynamic IP addresses.

WINS Not Supported

Windows Internet Name Service (WINS) is a name resolution service available
for Windows NT and Windows 2000. SWCC does not support WINS. Each
system, using SWCC, must have access to either a DNS server or a valid hosts
file.

Access Denied Problem

This section covers some of the most common reasons for a Client to receive
an "Access Denied" message when it attempts to add an agent system to the
Storage Window Manager.

 Client System Not on Agent’s List

The client system is probably not on the authorized client system list for the
Agent. To verify that the client system is included, view the list of client system
entries in the Agent Configuration utility. For information on how to add the
client system to an Agent’s list of client system entries, please refer to the User
Guide.
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 Multiple Agents

If the agent system is running multiple SWCC Agents (for example, to support
different controller types) then the client system must be authorized for all
Agents. If the client system is missing from any authorized Client list of an
Agent, then that Agent cannot be added to the Storage Window Manager.

 Aliases Not Checked

When SWCC Agents scan the Client authorization list, they do not check aliases.
The entry in the Client authorization list must match that returned by a
gethostbyaddr call in the hostent h_name field. SWCC will not scan the hostent
alias list to check if an alias may match the Client authorization list.

 Entry in the Client Authorization List Does Not Match

Generally, the entry in the Client authorization list for an Agent must match
what gethostbyaddr(<client IP address>) will return in the hostent h_name field
when gethostbyaddr(<client IP address>) is executed on the Agent system. If
hosts files are not exactly the same on all systems, the h_name returned may
vary on different Agent systems. For example,

xxx.xxx.xxx.xxx client.somewhere.com client

will return client.somewhere.com in the h_name field, but

xxx.xxx.xxx.xxx client     client.somewhere.com

will return client in the h_name field.

In some situations, you can configure the way a system uses DNS and its local
hosts file. Please refer to your system documentation to find how your system
is configured. Some systems may be configured to do the following:

• Check its local hosts file first, then go to DNS.

• Go to DNS first, then check its local hosts file.

• Ignore DNS even if configured.

• Ignore the local hosts file.

The best way to verify what needs to be used for a Client name in the Client
authorization list is to write a program that runs on the agent system and prints
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the h_name field returned by gethostbyaddr (<client IP address>). Remember
the dynamic IP address allocation is not supported.

 Adding New System by Using Internet Protocol Address May Cause Client
to Stop Responding

The SWCC Client may stop responding when you attempt to add a system by
using the agent system’s IP address rather than the agent system’s node name.
This occurs when the client system does not have a DNS server configured that
knows the agent system, and the agent system is not in the client system’s
hosts file. To correct this situation, add the agent system to the hosts file on the
client system.

If you receive an "Invalid host" or "Host not known" message when you
attempt to connect to an agent system, the solution is not to try the IP address.
Fix your DNS server configuration, or if that is correct, confirm that the DNS
server knows the agent system. If you are not using DNS, make sure the agent
system is in the client system’s hosts file.

Add New System by Using Internet Protocol Address Crashes

The SWCC Client may crash when you attempt to add a system by using the
agent system’s Internet protocol (IP) address rather than the agent system’s
node name. This occurs when the client system does not have a DNS server
configured that knows the agent system, and the agent system is not in the
client system’s hosts file. To correct this situation, add the agent system to the
hosts file on the client system.

If you receive an "Invalid host" or "Host not known" message when you
attempt to connect to an agent system, the solution is not to try the IP address.
Fix your DNS server configuration, or if that is correct, confirm the DNS server
knows the agent system. If you are not using DNS, make sure the agent system
is in the client system’s hosts file. Remember, WINS is not supported by SWCC.
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Running Message When Adding System to the Storage Window Manager

When trying to add a new system to the Storage Window Manager, you may
receive a message, stating "No Agent running on specified system." This
message can appear for several reasons. The error most likely occurred as a
result of one of the following actions:

• Wrong system name was entered.

• Agents were not installed on the entered system.

• Agents were installed on a system that stopped functioning.

• The specific Client required to support the Agents, running on the agent
system, was not installed. For example, if the agent system only has a
Fibre Channel Interconnect Agent and the client system has only a
HSZ22 Client, the "No Agent Running" message will appear.

• Port names and numbers in the services file may be missing or may not
match between Client and Agent. This may occur if the default value for
a SWCC port was already in use.

To check if Client support for an Agent had been installed, look at the following
registry key:

HKEY_LOCAL_MACHINE\Software\DigitalEquipmentCorporation\Command Console\AppletManager

You should see a series of keys for supported products.

 11.0 Documentation Update

Following are the additions and corrections to the Compaq StorageWorks
HSG60/HSG80 Array Controller ACS Version 8.5C Solution Software for IBM AIX
Installation and Configuration Guide (AA-RNJ8A-TE):

• Section 1.1: Solutions kit is not supported on IBM Host Bus Adapter (IBM
PN: 6227).

• Section 1.5, Bullet 3: Fibre Channel Switch is not supported; the
information regarding switch in the last part of the sentence should be
removed.

• Section 1.6: Sections 1.6.1, 1.6.2, and 1.6.3 are deleted.


